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4‘: SLEIRCC%E{L}CEDRSS WORKSHOP4 IDE

This user guide provides an introduction to Workshop4, the 4D Labs integrated development environment.
Workshop4 supports multiple development environments for the user, to cater for different user requirements and
skill level.

Serial
R —

The Designer environment enables the user to write 4DGL code in its natural form to program
4D Labs processors of choice.

A visual programming experience, suitably called ViSi, enables drag-and-drop type placement of
objects to assist with 4DGL code generation and allows the user to visualise how the display will
look while being developed.

An advanced environment called ViSi-Genie doesn’t require any 4DGL coding at all (PRO however
enables 4DGL code for a more powerful user interface), it is all done automatically. Simply lay
the display out with the objects required, set the events to drive them and the code is written
for the user automatically. ViSi-Genie provides the latest rapid development experience from 4D
Labs. (Not available for Goldelox)

A Serial environment is also provided to transform display modules powered by 4D Labs
processors into a slave serial module, allowing the user to control the display from any host
microcontroller or device with a serial port.

Additionally, Workshop4 also offers Arduino compatible environments that allows the user to easily create a project
with both a 4D and an Arduino product. More details can be found in Choose Your Arduino Compatible Environment.

To install Workshop4, please refer to the document Workshop4 Installation.
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2. Workshop4

There is an alias for 4D Workshop on the desktop:

E‘ e P ' - H e m E =

Launch 4D Workshop by double-clicking on the icon:

workshop
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3. Create a New Project

Workshop4 opens and displays the Recent page:

New

Recent (Click here to Clear)
'E Open W D KS PRO ColorPicker.aDGenie 8/20/2013 10:30 AM
e Recent

I
E-’ c:\Users\PubliciDocuments|4D Labs\Picaso Visi Genie\Colorider4DGenie

IDE Vversion 4.4.0.9 CLOCK.4DVisi 11/1/2011 3:43 FM
ﬂ a'a"' icker® m C:\Users\PubliciDocuments\4D Labs\Picaso ViSi\CLOCKADVIS
spIflashDemo.4dg 3/11/2014 7:59 AM
Create a new 4D Systems PrDject C:\Users\Public\Documents\4D Labs\Diablo DesignerPlashDemo.adg

Start building a new Visi, Genie, Designer or Serial program.

)
i
A

—1 5 Print Setup

@ .
Create a new 4D Labs Project
; Start building a new Visi, Genie, Designer or Serial program.
e
% Options

Help

2
@ Samples
x Exit

Create a new Project
Start building a new program using the same settings as you
last used (Arduino Extended Graphics 4Duina)

4D SYSTEMS 40 LABS

TURNING TECHNOLOGY INTO ART SEMICONDUCTORS

To create a new program, there are multiple options:

e  Click on the top left-most icon New
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4‘DSLIERCO%E{L}C$0RSS WORKSHOP4 IDE

Click on the icon close to Create a new 4D Systems Project on top
Click on the Create a new Project to create a project instance based on your last project settings.

Create a new 4D Systems Project

Start building a new Visi, Genie, Designer or Serial program.

Create a new 4D Labs Project

Start building a new Visi, Genie, Designer or Serial program.

Create a new Project
Start building a new program using the same settings as you
last used (Serial Gen4-uLCD-32DT)

Note:

Another option is displayed on the image above. Create a new 4D Labs Project is an upcoming
Workshop4 feature which allows to create a project with a customized display module powered by 4D
Labs’ processors

Both of the first two options update the main window with the selection of the screen:

Gen4-uLCD-28DT 240x320
2.8" Gen4Intelligent Display Module with embedded DIABLO16 processor v/ Resistive Toud
panel

Gen4-ulLCD-32D 240x320

3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processor F i ‘ H

Gen4-uLCD-32D-CLB 240x320
3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processorw/ Cover Lens Bezel

Gend-ulCD-32DT 240%320
3.2"Gen4Intelligent Display Module with embedded DIABLO 16 processor w/ Resistive Toudh
panel

Gen4-uLCD-32DCT-CLB 240x320
3.2"Gen4Intelligent Display Module with embedded DIABLO16 processor v/ Capacitive Touch ]
panel & Cover Lens Bezel

(e

Gen4-ulLCD-35D 320x480
3.5" Gen4 Intelligent Display Module with embedded DIABLO16 processor

Portrait (Click image to rotate)

Gen4-uLCD-35D-CLB 320x480
3.5"Gen4 Intelligent Display Module with embedded DIABLO16 processorw/ Cover Lens Bezel

Gen4-ulLCD-35DT 320x480
3.5" Gen4 Intelligent Display Module with embedded DIABLO 16 processor w/ Resistive Toudh
panel

Gen4-uLCD-35DCT-CLB 320x480
3.5" Gen4Intelligent Display Module with embedded DIABLO16 processorw/ Capacitive Touch

mamal 0. Favinn ] mam D ae

Al
Scroll using mousewheel, or click and drag using left mousebutton
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Select the screen, here the gen4-uLCD-32DT

Gend-ulLCD-32DT 240320
3.2" Gen4 Intelligent Display Module with embedded DIABLO 16 processorw) Resistive Toudh
panel

The selected screen is displayed:

& CHOOSE UR PRODU |
Gend-...-D,-DCT, DT ¥

Gen4-uLCD-28DT 240x320
2.8"Gen4Intelligent Display Module with embedded DIABLO16 processor w/ Resistive Toudh
panel

Gen4-uLCD-32D 240x320

3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processor f i ‘ q

Gen4-uLCD-32D-CLB 240x320
3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processor v/ Cover Lens Bezel

Gend-ulCD-32DT 240x320
3.2"Gen4Intelligent Display Module with embedded DIABLO16 processor w/ Resistive Toudh
panel

Gen4-uLCD-32DCT-CLB 240x320
3.2"Gen4Intelligent Display Module with embedded DIABLO16 processor wj/ Capacitive Touh
panel & Cover Lens Bezel -

Gen4-uLCD-35D 320x480
3.5"Gen4 Intelligent Display Module with embedded DIABLO16 processor

Portrait (Click image to rotate)

Gen4-uLCD-35D-CLB 320x480
3.5"Gen4 Intelligent Display Module with embedded DIABLO16 processor v/ Cover Lens Bezel

Gen4-uLCD-35DT 320x480
3.5" Gen4 Intelligent Display Module with embedded DIABLO 16 processor w/ Resistive Toudh
panel

Gen4-uLCD-35DCT-CLB 320x480
3.5" Gen4Intelligent Display Module with embedded DIABLO16 processorw/ Capacitive Touch
1

mmmal 0. Fasinr ] mmm D ae

Scroll using mousewheel, or click and drag using left mousebutton
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Orientation is portrait by default. To set it to landscape, just click on the image of the screen to rotate it:

CHOOSE YOUR PRODUCT

Gen4-...-D,-DCT,-DT ¥

Gen4-uLCD-28DT 240x320
2.8" Gen4Intelligent Display Module with embedded DIABLO 16 processor i/ Resistive Touch
panel

Gen4-ulLCD-32D 240x320
3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processor

Gen4-ulLCD-32D-CLB 240x320 3
3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processor wj/ Cover Lens Bezel

Gen4-uLCD-32DT 240x320

3.2"Gen4Intelligent Display Module with embedded DIABLO 16 processor vif Resistive Touch

panel

Gen4-uLCD-32DCT-CLB 240x320 —__.lg

3.2"Gen4Intelligent Display Module with embedded DIABLO 16 processor v/ Capacitive Toudh
panel & Cover Lens Bezel

Gen4-ulLCD-35D 320x480
3.5"Gen4 Intelligent Display Module with embedded DIABLO16 processor

Landscape (Click image to rotate)

Gen4-uLCD-35D-CLB 320x480
3.5" Gen4 Intelligent Display Module with embedded DIABLO16 processorvif Cover Lens Bezel

Gen4-ulLCD-35DT 320x480
3.5"Gen4Intelligent Display Module with embedded DIABLO 16 processor vif Resistive Toud
panel

Gen4-uLCD-35DCT-CLB 320x480
3.5"Gen4 Intelligent Display Module with embedded DIABLO 16 processor v/ Capacitive Toudh

mmnl O Favime ) Amem Bamal

Scroll using mousewheel, or click and drag using left mousebutton

Press Next to proceed:
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4‘DSLIERCO%E{L}C$0RSS WORKSHOP4 IDE

4. Choose Your 4D Environment

The main window now asks for the environment for the project:

CHOOSE YOUR ENVIRONMENT | s‘,’sii';@ et

File File

Designer

The Designer environment enables the user to write 4DGL code in its A visual programming experience, suitably called ViSi, enables drag and

natural form to program the display module. drop type placement of objects to assist with 4DGL code generation and
allows the user to visualise how the display will look while being
developed.

"5( Print Setup

e

-

L Options
ViSi Genie ‘ Serial

@ Help

@ Samples An advanced environment called ViSi-Genie doesn't require any 4DGL A Serial environment is also provided to transform the display into a slave
coding at all, it is all done for you. Simply lay the display out with the serial module, allowing the user to control the display from any host
objects you want, set the events to drive them and the code is written for microcontroller or device with a serial port.

x Exit you automatically. ViSi-Genie provides the latest rapid development

experience from 4D Systems.

Four main environment options are available:
e Designer,

e ViSi,
e ViSi-Genie,
e Serial

...and two editor options:
o  Create System File,
e (Create Text File.

Each option opens a customised environment with specific commands and controls. Different projects using different
modules and environments can be opened simultaneously on Workshop4. The toolbar ribbon will adapt to the project
tab that is selected, to suit its environment.

WORKSHOP4 USER GUIDE Page 10 of 49 www.4dlabs.com.au
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4‘DSLEIQCC%E{L}C$DRSS WORKSHOP4 IDE

The Designer environment enables the user to write 4DGL code in its
natural form to program the display module.

The Designer environment enables the user to write 4DGL code in its natural form to program the display module.
4DGL is a graphics oriented language allowing rapid application development, and the syntax structure was designed
using elements of popular languages such as C, Basic, Pascal and others.

%ij [ u ol L[ \ A\ ~ A I —
JEHRE AL EKOB OO0 LOO06 » = E 8§ O
Mew Open  Save SaveAs  Print Cut Copy Paste Delete Undo Redo Clear All - Mext Prev Set Find Replace Goto  Find Again Collapse Al Expand All Compile Comp'nLoad
File Clipboard Undo/Redo Bookmarks Find Cade Folding Compile
4b
|2 noName 1= [x]

form "Gen4-ulCD-32DT"

t "4DGL_16bitColours.fnc”
nc main()

NDSCAPE) ; /.

Insert Press F1 for context sensitive help ,:}

To learn more about Designer, please to refer to the 4DGL Internal Functions Reference Manuals and 4DGL
Programmers Reference Manual on the Workshop4 product page and the related application notes on the Application
Note page. You can also refer to 4D Systems’ application notes.

WORKSHOP4 USER GUIDE Page 11 of 49 www.4dlabs.com.au


http://4dlabs.com.au/workshop4-ide
http://4dlabs.com.au/appnotes.html
http://www.4dsystems.com.au/appnotes

4‘3 SEMICC%E{L}%RSS WORKSHOP4 IDE

A visual programming experience, suitably called ViSi, enables drag and
drop type placement of objects to assist with 4DGL code generation
and allows the user to visualise how the display will look while being
developed.

A visual programming experience, suitably called ViSi, enables drag-and-drop type placement of objects to assist with
4DGL code generation and allows the user to visualise how the display will look while being developed.

0
v e
[ =Nl X 66 OB s 10 % =E & O
+ = 2 6 B A @ A = =
qan
[Thoniame 1= x]
n4-ulCD-32DT" || Form1
D w1
L]
t "NoNamelConst.inc™
Object Inspector ey
‘ Form  Formi ~
Object | Formt -
Alias Form1
Color Weacx
& source
Insert

Press F1 for context sensitive help ;2

To learn more about ViSi, please to refer to the ViSi User Guide on the Workshop4 product page and the related
application notes on the Application Note page. You can also refer to 4D Systems’ application notes.
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4‘: SLEIRCC%E{L}C?DRSS WORKSHOP4 IDE

ViSi Genie

An advanced environment called ViSi-Genie doesn't require any 4DGL
coding at all, it is all done for you. Simply lay the display out with the
objects you want, set the events to drive them and the code is written
for you automatically. ViSi-Genie provides the latest rapid development
experience from 4D Systems.

An advanced environment called ViSi-Genie doesn’t require any 4DGL coding at all, it is all done for the user. By simply
laying the display out with the wanted objects and setting the events to drive them, the code is written automatically.
ViSi-Genie provides the latest rapid development experience from 4D Labs.

Home

pr—

E ﬂ n (Badgrounds Buttors  Digls Gauges 0 Inpus Lsbes Megc  Pumitves  Systemeca [y |
= @ b [ —

Ho NEU |

Build {Build)
Copv/load Copv/Load
File Build

Mew Open Save SaveAs  Print

4k

[ElinoName 1= [x]
[rnrmo 23| | Object Inspector &
( Form | Form0 ~
1 Object | Form0 ~
Properties Events
MName Form0
Alias Form0
Batype Color
Color WsLack
Image one,

Source

Insert Press F1 for context sensitive help .::

To learn more about ViSi-Genie, please to refer to ViSi-Genie User Guide on the Workshop4 product page and the
related application notes on the Application Note page. You can also refer to 4D Systems’ application notes.

Workshop4 PRO enables advanced features for ViSi-Genie, enabling 4DGL code to be used, allowing for increased
customisation and flexibility on this already powerful environment. Please refer to the Application Notes for more
information on Workshop4 PRO (specifically Genie Magic and Smart Widgets).
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4‘DSLIERCO%E{L}C$0RSS WORKSHOP4 IDE

4.4. Serial

Serial

A Serial environment is also provided to transform the display into a slave
serial module, allowing the user to control the display from any host
microcontroller or device with a serial port.

The Serial environment is provided to transform the module into a slave serial module, allowing communication and
control from virtually any host micro-controller or device with a serial port.

For detail on this environment and steps on how to make your display module run under the Serial environment,
please refer to the Serial Command Set Reference Manual on the Workshop4 product page and the related application
notes on the Application Note page. You can also refer to 4D Systems’ application notes.
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The Create System File option provides an editor for all 4DGL-related projects, so a user can create or edit a 4DGL
Include file, 4DGL Library file, a Function or System file. These can then be included in the user’s 4DGL code.

Ls

= 0 L . = e
=< 3 l
. I E E = % 9 -4 6 B 4@ n
New Open Save  Save As Print Cut Cop Paste Delete Undo Redo Clear Al Next Prev Set Find Replace  Goto  Find Again
File Clipboard Undo/Redo Bookmarks Find

NeName 1.inc™ [x]

»1

Insert Press F1 for context sensitive help .:i|
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4‘DSLEIHCC%E{L}C$DI§S WORKSHOP4 IDE

Create
=6
File

The Create Text File environment features a plain editor, suitable for writing basic documentation, application notes,
data files or anything else requiring plain text files.

New Open Save SaveAs Paste do | ClearAll MNext Prev  Set Find Replace Goto Find Again

BB KOO 50065 1 OO 5

File Clipboard Undo/Redo Bookmarks Find

NoName 1. bt [x]

»1

Insert Press F1 for context sensitive help .:i|
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hoose Your Arduino Compatible Environment

When choosing a 4D Systems product, you can see that there is a product group named Arduino Compatible which
includes both the Internet of Displays (loD) Modules and 4Duino. It also includes a wide range of 4D Systems’ display
modules setup with an Arduino board.

Gen4-IoD-32T 240x320
3.2"QVGA IoD module

4Duino 240x320
2.4"QVGA powered by ATmega32U4, PICASO and ESP8266

uLCD-24PTU-AR 240x320
2.4"QVGA Intelligent Touch ScreenLCD Module and Adapter shield

uLCD-28PTU-AR 240x320
2.8" QVGA Intelligent Touch ScreenLCD Module and Adapter shield

ulLCD-32PTU-AR 240x320
3.2"QVGA Intelligent Touch ScreenLCD Module and Adapter shield

ulLCD-43PT-AR 480x272
4.3" IntelligentLCD Modulew/ Resistivetouch and Adapter shield

uLCD-220RD-AR 240x320
1.38"Diablo16 Round Intelligent LCD Module and Adapter shield

uLCD-35DT-AR 320x480
3.5"Diablo16HVGA Intelligent Touch Screen LCD Module and Adapter shield

Scroll using mousewheel, or click and drag using left mousebutton

Workshop4 allows the users to write their Arduino code and customize their 4D graphics user interface at the same
time in a single integrated development environment.

Basic Extended Genie
Graphics Graphics Graphics
- - _2)

The Arduino compatible Basic Graphics
environment enables the user to write Arduino
code directly to program this Arduino
compatible module. It requires no uSD card
and allows graphics primitives to be dragged
and dropped on the screen and placed in your
code. It utilises the Serial SPE library for the
processor used in the display, and therefore
embraces the full set of Serial SPE Commands
are available to the User, to produce the
Graphical User Interface required.

A visual programming experience, suitably
called Arduino compatible Extended Graphics,
enables drag-and-drop type placement of
‘Workshop4 objects to assist with Arduino code
generation and allows the user to visualise how
the display will look while being developed. A
uSD card will be required in order to hold the
graphics. It utilises the Serial SPE library for
the processor used in the display, and
therefore embraces the full set of Serial SPE
Commands are available to the User, to
produce the Graphical User Interface required.
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In the meantime you can continue developing
Genie Arduino applications using the current
tools

& &
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4‘DSLIERCO%E{L}C$0RSS WORKSHOP4 IDE

5.1. Basic Graphics

Basic
Graphics

The Arduino compatible Basic Graphics environment enables the user to write Arduino code directly to program this
Arduino compatible module. It requires no uSD card and allows graphics primitives to be dragged and dropped on the
screen and placed in your code. It utilizes the Serial SPE library for the processor used in the display, and therefore
embraces the full set of Serial SPE Commands are available to the User, to produce the Graphical User Interface
required.

5.2. Extended Graphics

Extended
Graphics

A visual programming experience, suitably called Arduino compatible Extended Graphics, enables drag-and-drop type
placement of Workshop4 objects to assist with Arduino code generation and allows the user to visualize how the
display will look while being developed. A uSD card will be required in order to hold the graphics. It utilizes the Serial
SPE library for the processor used in the display, and therefore embraces the full set of Serial SPE Commands are
available to the User, to produce the Graphical User Interface required.

5.3. Genie Graphics

Graphics

An upcoming feature is an advanced environment called Arduino compatible Genie Graphics which utilizes the
popular ViSi-Genie technology that is available in most 4D Systems Intelligent Displays. It utilizes the genieArduino
library, and allows rapid development of GUI due to the powerful tools and widgets Workshop4 provides. Simply lay
the display out with the objects you want, set the events to drive them and then utilize the genie functions inside the
Arduino sketch to read or write information to those objects from the Atmel processor. This is a very clean and rapid
development environment.

In the meantime, you can continue developing Genie Arduino applications using the current tools, by simply selecting
the base module without the -AR extension, from Workshop4, and utilize the standard ViSi-Genie environment with
our Arduino library.
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6. Common File Menu

The File Menu is the first menu and common to all environments...

New

Recent (Click here to Clear)
IE Open W D KS PRO ColorPicker.4DGenie 8/20/2013 10:30 AM ¢
e Recent

e
E" C:\Users\Public\Documents\4D Labs\Picaso ViSi Genie\ColorPiderADGenie

IDE Version 4.4.0.9 CLOCK.4DVisi 11/1/2011 3:43 PM E
ﬂ a-a!%ﬂi'“ m C:\Users\Public\Documents\4D Labs\Picaso ViSil(LOCKADVES
spPIflashDemo.4dg 3/11/2014 7:59 AM
Create a new 4D SyStemS PrDject C:\Users\Public\Documents\4D Labs\Diablo DesignergPilashDemo.4dg

Start building a new Visi, Genie, Designer or Serial program.

)
i
A

—:# Print Setup
Create a new 4D Labs Project
; Start building a new Visi, Genie, Designer or Serial program.
e
% Options

2150 < j Create a new Project
D Start building a new program using the same. settings as you
@ Samples ﬂl last used (Arduino Extended Graphics 4Duina)
x Exit
4D SYSTEMS 40 LABS

TURNING TECHNOLOGY INTO ART SEMICONDUCTORS

Scroll using mousewhesl, or click and drag using left mousabutton

...with various buttons relating to the project that is open (or greyed out if no project is open):

. File-related buttons,
. Print-related buttons,
o And miscellaneous buttons, such as Help, Options and Samples.
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1. File-Related Buttons

The buttons include all the actions related to projects: New, Open, Recent, Save, Save As, Zip Project and Close project.

The options include:

Click New to create a new project. A dialogue window asks for the screen and the kind of project.

CHOOSE YOUR PRODUCT

CEE—

2.4"Gen4 Intelligent Display Module with embedded DIABLO16 processor

Gen4-ulLCD-24D-CLB 240x320
2.4"Gen4 Intelligent Display Module with embedded DIABLO16 processor w/ Cover Lens Bezel

Gen4-ulLCD-24DT 240x320
2.4"Gen4 Intelli Display Module with embedded DIABLO 16 processor v/ Resistive Toudh
panel

Gen4-uLCD-28D 240x320
2.8" Gen4 Intelligent Display Module with embedded DIABLO16 processor

Gen4-ulLCD-28D-CLB 240x320
2.8" Gen4 Intelligent Display Module with embedded DIABLO16 processor vif Cover Lens Bezel
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Gen4-ulLCD-28DT 240x320
2.8" Gen4 Intelligent Display Module with embedded DIABLO16 processorwj Resistive Touch
panel

Gen4-ulLCD-32D 240x320
3.2" Gen4 Intelligent Display Module with embedded DIABLO16 processor

Gen4-uLCD-32D-CLB 240x320
3.2"Gen4 Intelligent Display Module with embedded DIABLO16 processor w/ Cover Lens Bezel

Gen4-ulLCD-32DT 240x320
3.2"Gen4Intelligent Display Module with embedded DIABLO 16 processor v/ Resistive Toudh

it

Scroll using mousewheel, or click and drag using left mousebutton
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Click Open to browse and open an existing project. A standard Open window opens.

« w A <« Users » Public » Public Documents » 4D Labs w 0 Search 4D Labs o
Organise = MNew folder =~ 1 @
MName Date modified Type Size ~
5 Quick access
4Duino 47472016 9:20 AM File folder
&# Dropbox (4D Team) 4DUpdates 4/27/2017 217PM  File folder
i 47472016 9:20 AN i
& OneDrive Animated Buttons 47472016 9:20 AM File folder
Arduino 47472016 9:20 AM File folder
[ This PC Diablo Designer 42772017 217 PM  File folder
d’ Network Diablo Serial 47472016 9:20 AM File folder
N Goldelox Designer 4/4/2016 9:20 AM File folder
Goldelox Senial 4/4/2016 9:20 AM File folder
Goldelox Vi5i 472772017 217 PM File falder
Images 4/27/2017 217 PM File folder
Picaso Designer 4/4/2016 9:20 AM File folder
Picaso Serial 47472016 9:20 AM File folder
Picaso ViSi 472772017 217 PM File folder
Mirara WG Cmmin AMTNAT 717 NKA Cilm fnlddmr <
< >
File name: v| Alfiles () v

Select ViSi-Genie projects among the different kinds listed below to load a ViSi-Genie project:

All files (*.%) W I
Designer projects (*.4dg)

Visi projects (*.4dVisi)

Visi Genie projects (*.40Genie)
4DGL Misc files (*.inc* fnc™.sys ™ lib
40 Display Defintions (*.4DdisplayDef)
Basic Arduine projects (*4dArdBasic)
usD Arduine projects (* 4dArdUsd)
Genie Arduino projects (*.4dArdGenie)
All files (*.%)
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Click Recent to list the recently accessed files, and click on the project to open it.

New

E+)

e

Recent (Click here to Clear)

P RO ColorPicker.4DGenie 8/20/2013 10:30 AM
W D K S D ﬁ-j €:\Users\Public\Documents\4D Labs\Picaso Visi Genie\Colofider4DGerie

E e Recent “
- IDE Version 4.4.0.9 CLOCK.4DViSi 11/1/2011 3:43 PM
ﬂ ?E-a:%ﬁi'“ m C:\Users\PubliciDocuments\4D Labs\Picaso ViSi\CLOCKADVIS
SPIflashDeme.4dg 3/11/2014 7:59 AM
Create a new 4D Systems PrOject C:\Users\Public\Documents\4D Labs\Diablo Designen@HashDemo.Adg

Start building @ new Visi, Genie, Designer or Serial program.

i

—.';f. Print Setup
Create a new 4D Labs Project
;‘ Start building a new Visi, Genie, Designer or Serial program.
e
& Options

@ - < j Create a new Project
D Start building a new program using the same settings as you
@ Samples ﬂl last used (Arduino Extended Graphics 4Duina)
% Exit
4D SYSTEMS 4D LABS

TURNING TECHNOLOGY INTG ART SEMICONDUCTORS

Seroll using mousewhesl, or click and drag using left mousebution

Click Save to save the modified projects.
Click Save As to create a copy of already saved project and give it a new name. A standard Save window opens and
asks for the location and the name:
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*
« = ~ 4 <« Users » Public » Public Documents » 4D Labs v O Search 4D Labs pel
Organise « Mew folder == - 0
MNarne Date modified Type Size 2
7 Quick access
4Duino 47472016 %:20 AM File folder
£# Dropbox (4D Team) 4DUpdates A/ 2772017 217 PM File falder
& OneDrive Animated Buttons 4/4/2016 9:20 AM File folder
Arduine 4/4/2016 9:20 AM File folder
> E This PC Diablo Designer 42772017 217 PM File folder
& Network Diable Serial 4/4/2016 9:20 AM File folder
- Goldelox Designer 4/4/2016 9:20 AM File folder
Goldelox Serial 474/2016 5:20 AM File falder o
£ >
File name: | MNoMamel.4DGenie v|
Save as type: |Visi Genie projects (*.4DGenig) ~ |
# Hide Folders Cancel
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Click Zip Project to make a compressed file out of the project. This is especially useful when then project is large and
contains pictures and videos.

Click Close to close the current project. You will be prompted to save the changes to any modified project.

o Save Changes to NoMNamel.4dg?

Yes Mo Cancel

The buttons include all the actions related to print:

v
1

w0 Print Setup

S

1 L
—

e

Click Print Setup to setup the printer:

Printer
Mame: Microsoft ¥PS Documert Wiiter e Properties. ..
Status: Ready

Type: Microsoft XPS Document Writer w4
Where: PORTPROMPT:
Comment:

Paper Crientation
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Size: Ad w (®) Portrait

Source: | Automatically select v () Landscape

Network... —
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Click Print to print the project:

Printer
Mame: Microsoft ¥PS Documert Wiiter e Properties. ..
Status: Ready

Type: Microsoft XPS Document Writer w4
Where: PORTPROMPT:

Comment:

Prirt range Copies

Al Mumber of copies: 1 =
(_)Pages  from: |1 | to: |1 |

3 3 Collate
() Selection Jgu JEJ
s

The Miscellaneous buttons include Options, Help, Samples and Exit.

Options
&

o

@ Samples
? Exit
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Click Options to set the options for the current project:

Arduino  Compiler Designer Editor Environment (Generated Files | Genie | License Serial Shortcuts Updates

Note: 200,000 baud is a reliable baud rate match for 4D Systems displays to the Arduino. Due
to accumulated inherent baud rate error percentages in both systems, other rates above
56,000 are not reliable.

Default Baud Rate 200000 v

Default Sound Buffer | 1024 w

Comms Part Diablo com 1 Pins Default com port for new Genie Projects. COMD is always

@0 RXPin \PAD | pon fixed pins, as is COM1 for Picaso. For Diablo you need
to specify pins when using COM1.
O1 TEFin PAl ~
Maximum String Length Each addition byte of string length uses 3 bytes of RAM.

This is for 'normal’ strings and should be doubled for Unicode strings. i.e.
If you use unicode strings set value to max unicode string length * 2

List objects by Alias name first.

Visi  Warnings

Mounting... message |Mounﬁng. A | These strings can only contain ASCII

Drive not mounted. .. message |Drive not mounted. .. | newline sequence.

X corce

Options include different panes. Select “Environment”.

characters. They can also indude the \n

Arduine  Compiler Designer Editor | Environment | Generated Files Genie License Serial Shortcuts Updates  Visi  Warnings

Reopen Files that were open when Waorkshop was dosed Image [ Video Resample Quality

O Fastest
= '
Show Hints O Scaled
¥ Save as Opens Both () Box
Backup Files when saving (O spline
Bilinear
Open files Collapsed O
() Bicubic
Style: Office2010Blue v (® Lanczos

Tab Color D

X carc

Select the Style among different possibilities.
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The Image / Video Resample Quality selection brings different options:

e  Fastest
e Scaled
e Box

e Spline

e Bilinear
e Bicubic
e lLanczos

Click Help to access help, with links to the 4D website:

To access the 4D systems home page

Workshop 4
Version: 4.4.0.9

Copyright: 2015 4D Systems
For Peer help and support

For manuals and other documentation visit the
downloads tab on the page for your product

To report documentation errors and other hardware or
software issues, raise a case from the contact page

3

Also, see the Samples item for the location of various samples.
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Click Samples to access examples from 4D, with pre-defined filters:

SAMPLES

Samples were loaded onto your hard drive as part of the installation
rocess for Workshop

v 4D Labs - Click to browse all files
» -4Duino
» - Arduino
- Diablo Designer
- Diablo Serial - Click to browse
- Goldelox Designer - Click for filtered browse
- Goldelox ViSi - Click for filtered browse
- Goldelox Serial - Click to browse
- Picaso Designer - Click for filtered browse
- Picaso ViSi - Click for filtered browse
- Picaso ViSi Genie - Click for filtered browse
- Picaso Serial - Click to browse
--\i5i Genie Magic (Picaso/Diablo) - Click to browse

4D has a codebase of useful code and snippets that may come in handy
Click here to wisit the Forum Codebase

The 4D website contains a host of application notes

Click here to wvisit the 40 App Motes

Also, see the Help item for the location of various help information.

L3

Click Exit to close Workshop4. You will be prompted to save the changes to any modified project.

o Save Changes to NoMamel.4dg?

No Cancel
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7. Designer Specific Menus

The Designer environment includes five menus:

Home

7.1. Home Menu

The Home menu is the main menu.

+ BB AKX OB 06 LOO X == & O

Mew  Open Save SaveAs  Print Cut Copy Paste Delete Undo Redo Clear All - Next Prev Find Replace Goto FmdAgam Collapse Al Expand All Compile Comp'nLoad

File Clipboard Undo/Redo Bookmarks Find Cede Folding Compile

...with three groups of buttons:

. File-related commands,
. Build command,
o And the objects pane.

The file-related buttons include the same commands as seen in the File menu: New, Open, Save, Save As and Print.

S WEB e

Open  Sawe  Save As ri

File

The code related buttons include the standard Windows commands of Cut, Copy, Paste, Delete, Undo and Redo.

4 JCXK 66

Cut Copy  Paste Delete Undo Redo
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Clipboard Undo/Redo
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The bookmark buttons include Set a bookmark, go to Next or Previous bookmark and Clear All bookmarks.

% © 06 s

Clear All Mext Prev Set

Bookmarks

Bookmarks are shown close to the line number:

Bookmarks are especially useful for large projects.

The find and replace buttons provide the basic features for code.

Find Replace Goto Find Again

Find

The Find button prompts for a string and highly it in the code:

qb
E]NoNameZ‘ [x]

#platform "Gend-ulLCD-28DT"

#inherit "4DGL_16bitColours.fnc”

1

func main()
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E o print("Hello World") ;
11

H 12

13

14

15 endfunc
16
& 4» @ [whole words []Case Sensitive @ This file (O Filesin project () All open files 1match found

Use the up and down arrows to look for the previous and next occurrence. Check Whole Words and Case Sensitive.
Choose between This file and Files in progress and All Open Files.

(® This file () Files in project () All open files
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The Replace button searches for a string and exchanges it with another string:

a8k
NoNameZ‘ [=]

#platform "Gend-ulLCD-28DT"

#inherit "4DGL_16bitColours.fnc”

c main()

& 4=  [Owholewords []Case Sensitive @ This file (O Filesin project O All open files

Same options as for Find apply.

The Goto button prompts for a line number:

Mew Line?

The code folding buttons allow to collapse or expand a function:

Collapse All  Expand All
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Code Folding

This is especially useful for large projects.
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The Compile button launches the compilation of the project while the Comp’nLoad compiles and uploads the project

to the screen.

&% O

Compile Comp’nLoad

Compile
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Bl H

Graphics ~ uSD  PmmC .o Terminal  Terminal Touch 4DGL
Composer Tester Loader 9600 115200  Calibration  uVGA Link

All the tools and utilities are grouped here:

e  Click PmmC Loader to start the PmmC Loader utility.

e Click ‘Terminal connect 9600’ to open the currently selected com port at 9600 baud in the Terminal program.

e Click ‘Terminal connect 115200’ to open the currently selected com port at 115200 baud in the Terminal
program.

e  Click Touch Calibration to calibrate the touch on the display. This tool is not available for all display modules.

e Click 4DGL uVGA Link to open a window which can interact with the uVGA, enabling a mouse and keyboard
to be used with the uVGA(GFX) module. Demo code is available from Workshop4.

e Click Graphics Composer to open the Graphics Composer tool. This tool is used for creating graphics for a
Designer project. If graphics is needed for a Designer project, it is recommended to use ViSi instead.

e  Clik uSD Tester to test the uSD card mounted on the display. Before clicking this button, make sure that the
uSD card is mounted on the display module.

e Click RMPet to partition the uSD card. The uSD card must be mounted to the PC.

This menu is in charge of the communication port:

Status at 9:29:59 AM
coM3 ~
uLCD-43DT-A [v2.0, 16/05/16]
L ) {uSD: 3.5 GB)

Comms

The use of this menu is described at the section Connect the Module.
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The Project menu includes different parameters and options...

n n Allow -ve Led and Custom - Gemnd-ulCD-230T -

Digits and leading blarks
RAM | Flash on Custom Digits

Destination Enhancements Display

...with three groups of buttons:

. Destination,
o Display selection.
. And Enhancements

The first group includes the options for the destination:

REAM Flash

Destination

Select the Destination among two possibilities:

e RAM means the display must be connected during build and that the program will be downloaded to the
display’s RAM memory once compiled. If RAM is chosen as the destination, the program is lost when the
display is turned off.

e  Flash means the display must be connected during build and that the program will be downloaded to the
display’s flash memory once compiled. If flash is chosen as the destination, the program is retained and will
be available after power cycling.
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The second section contains a button for enabling the use of negative values for LED digits and custom digits objects
and for enabling the use of leading blanks on custom digit objects.

Allow -ve Led and Custom
Digits and leading blarks
on Custom Digits

Enhancements
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The third section allows to select the screen. Clicking on the button...

- Gend-ulCD-280T -

Display

...opens a new window to select the screen:

Change Display X

™ ™ Gen4-uLChD-280T ~

Qrientation
(®) Portrait
() Landscape
(") Portrait Reversed
i) Landscape Reversed

Display and options shown for
reference purposes only,
changes will not affect your
code.

X cos

Select the screen from the drop-down list:

Gend4-uLCD-280T b
Gend4-uLCD-230T ~
Gend4ulLCD-32D0
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Gen4-uLCD-32D-CLE
Gen4-uLCD-32DT
Gen4-uLCD-32DCT-CLE [
Gen4-uL.CD-350
Gen4-uLCD-350-CLE
Gen4-uLCD-350T v
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Define the orientation among the four options:

QOrientation
(@) Portrait
() Landscape
() Portrait Reversed
(J Landscape Reversed

Confirm by clicking on or deny by clicking on x e .
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8. ViSi Specific Menus

The ViSi environment includes all the menus available with the Designer environment plus two additional menus:
View and Widgets.

The View menu includes one important tool for visualising the form:

& 006

Object Reset Object
Fa 5 hot
Inspector m L LS view  Locations

Possibly hidden Forms

Click on Snapshot to open a specific window of the form to enable a 1:1 screenshot of the display to me made.

2 Spapshot O X

Z
£0203040506 Refresh | Save | Save Screen

(

This window provides a zoom up to 4 times. The Save button allows to save the screen as an image.

Object Inspector, Form, and Reset View, all relate to the menus and tool bars used in Workshop4. These toolbars and
menus can be moved and detached from the side of Workshop4. Object Inspector and Form will bring to front the
relevant toolbar when clicked. If required, the toolbars can be reset back to their default location by clicking the Reset
View button.

Object Locations enables the user to copy the locations/coordinates of objects on the display, to the clipboard.
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The Widgets menu includes the objects pane with all the objects available to build the interface:

' Backgrounds  Buttons  Digits  Gauges Inputs  Labels  Primifves  SystemMedia
= 7y =
=@ NS

The objects —also called widgets—are detailed in the ViSi User Guide.
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9. ViSi-Genie Specific Menus

ViSi-Genie includes five menus with specific ribbons and options.

Home

ViSi-Genie is codeless and thus completely different from the previous code-based environments, all the menus
relating to ViSi-Genie are detailed.

9.1. Home Menu

The Home menu is the main menu.

|=H
New

E ﬂ ﬂ at @ @ |Backgrounds Buttors  Digts Gauges 1jO  Inputs labels Magic  Primitves (m\rw
—

Build {Build) a
Open Save  Saveds Pt oload  copwload [. | o

File Euild

...with three groups of buttons:

e  File-related commands,
e Build command,
e And the objects pane.

The file-related buttons include the same commands as seen in the File menu: New, Open, Save, Save As and Print.

s @O H=

Open Save SaveAs  Print

File
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The Build button launches the compilation and the upload of the project to the screen.

Build {Build)
Copy/load Copy/load

Build
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The objects pane includes all the objects available to build the interface:

| Backgrounds  Buttons  Digits = Gauges IJO  Inputs  Labels  Magic Primitives

[Ol_A\.:

e The objects are detailed on the ViSi-Genie User Guide.

The View menu includes one important tool for visualising the form:

& 006

Object Reset Db ject
Fa 5 hot
Inspeactor m L LS view  Locations

Possibly hidden Forms

Click on Snapshot to open a specific window of the form.

42 Snapshot

Zgqm
& 02030405 (6 | Refresh | | Save |  Save Saeen

This window provides a zoom up to 6 times. The Save button allows to save the screen as an image.
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R @ % % 21121 O

Boot usD PmmC Terminal Termlnal Touch
s TR e RMPEt  “o600 115200  Calibration

40GL

Loader ulGA Link

GTX

All the tools and utilities are grouped here:

e Click Boot uSD to upload the boot-loader to the screen, enabling programs to be loaded via microSD card.

e  Click PmmC Loader to start the PmmC Loader utility.

e Click ‘Terminal connect 9600’ to open the currently selected com port at 9600 baud in the Terminal program.

e Click ‘Terminal connect 115200’ to open the currently selected com port at 115200 baud in the Terminal

program.
e Click Touch Calibration to calibrate the touch on the screen. This tool is not available for all

display modules.

e Click 4DGL uVGA Link to open an interactive window to use mouse/keyboard with the uVGA(GFX) module.

e  Click GTX to launch the Genie Test Executor debugger.

For Diablo16 display modules, the Boot uSD icon is replaced with the Update Bank(s) and Run icon.

BELBOD D O

usD PrmimC Terminmal Termlnal Touch
I 9600 115200 Calibration

|Update Bank(s}
and Run

4DGL
UVGA Link

GTX

Clicking the GTX button, a new screen will appear with the form and objects defined in the project:

Genie Test eXecutor

Confrol
Port: |COM 3 [Jreset on open u“@, QiSCOﬂﬂECt| |? = | Contrast 9600 baud
Active Form
Query
ColorPicker
Query

[]

Set
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This menu is in charge of the communication port:

Status at 9:29:59 AM
COM3
ULCD-430T-A [v2.0, 16/05/16]

. {uSD: 3.68 GB)

Comms

The use of this menu is described in Connect the Module.

The Project menu includes different parameters and options...

Destination Initial Form Comms Speed: 9600

Run Run 7| Allow buttons
usD Faorma - .
W oan | e ® Flash . Sound Buffar: 1024 - to be disabled

Genie
Allow e Led and Custom Gend-ulCD-32D0T
Digits and leading blarks LANDSCAPE -
on Custom Digits
Enhancements Display

...with three groups of buttons:

e  Options for Genie,
e  Parameters and Enhancements
e And display selection.
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For Picaso display modules, the first group includes the options for Genie:

Destination Initial Farm
Run Bun
e DTVVRIRE  J P B 50| || [Formo -
Genie

e Select the Destination among three possibilities:

o Run RAM - The display must be connected during Build and the program will be downloaded to the
display’s flash memory once compiled. The user’s application will be stored in Flash, but will be run from
RAM.

o Run Flash - The display must be connected during Build and the program will be downloaded to the
display’s flash memory once compiled. The user’s application will be stored and run from flash, this uses
less memory on the display, but makes programs run slightly slower.

o uSD - The user’s application will be built and copied to the uSD card. From the uSD card the application
is loaded into RAM and run from there. This option requires the Boot uSD program to be uploaded to
the display’s flash, as seen in the menu Tools. This Boot uSD program loads the user’s application from
the uSD card at startup, and executes it. For Diablo, Boot uSD is called Update Bank(s) and Run.

P

Boot

usD Update Bank(s)
and Run

e Theinitial form section allows the user to set which form will show upon boot up.

For Diablo16 display modules, the first group looks like as shown below.

Destination

Run Run
e RAM T Flash

A 0

Bank 0 |

Bank 1

) ) Bank 2
- Bank 3
Bank 4

Bank 5
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The additional drop-down menu allows the user to specify the target destination flash bank of the ViSi-Genie program.
The Diablo16 processor has six flash banks (Bank 0 to Bank 5), each of which has a capacity of 32 kB.

When Run Flash is selected, the destination of the ViSi-Genie program is the bank specified in the drop-down menu.
In this case, the display module needs to be connected to the PC during build time. The program will then be
downloaded to the selected bank and it will run from there. Take note however, that, after the display module is
power cycled, the program in Bank 0 always runs first.

On the other hand, when uSD is selected, the ViSi-Genie program will be copied to the uSD card. This option does not
require the display module to be connected to the PC during build time. However, this option requires the Update
Bank(s) and Run program to be downloaded to Bank 0 of the display’s flash memory. The Update Bank(s) and Run
program button is found under the Tools menu.
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AXEEEN N Y

|Update Bank(s} Renumber usD PmimC Terminal Terminal Touch 40GL
and Run Tester Loader 9600 115200  Calibration  uVGA Link

This Update Bank(s) and Run program checks the uSD card for ViSi-Genie program files and copies them to their
destination flash banks. Then, by default, the program in Bank 1 is executed. The Update Bank(s) and Run program
can be modified to run the code in another bank besides Bank 1 if desired.

Note that Update Bank(s) and Run program stores the time and date information of ViSi-Genie program files (for all
banks) in Bank 0. Every time that the display module is power cycled, Update Bank(s) and Run in Bank 0 always runs
first and checks the time and date information of the ViSi-Genie program files present in the uSD card. By default, if
the time and date information of a ViSi-Genie program file is different from that of the last program file uploaded to
the same bank, Update Bank(s) and Run automatically updates the specified bank.

It is also possible to modify the Update Bank(s) and Run program such that it only updates the target banks only if
the corresponding ViSi-Genie program files in the uSD card have a newer time and date information.

The second group includes advanced parameters:

Comms Speed: 9600 - Allow -ve Led and Custom
Allow buttons .. .
to be disabled Digits and leading blarks
Sound Buffer: 1024 « an Custom Digits
Enhancements

e Comms speed is the baud rate at which the serial command interface operates

e Define Sound buffer size for the amount of memory set aside for buffering wav (sound) files. For simple
sound files 1024 bytes should be enough. For complicate sound files to be played whilst video is displaying
may need as much as 4096 bytes.

e  Button objects have the ability to be shown and hidden accordingly by the host controller. To enable this,
click on the “Allow buttons to be disabled” button. Then use the GTX tool to see the appropriate commands
for enabling and disabling the buttons.

e The right-most button allows for enabling the use of negative values for LED digits and custom digits objects
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and for enabling the use of leading blanks on custom digit objects.
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The last section allows selecting the screen, useful for converting a program from one display module to another.

- Gerd-ulCD-280T -

Display

Clicking on the button...

...opens a new window to select the screen:

Change Display *

™ e Gend-ulLCh-28DT ~

Orientation
(®) Portrait
(U Landscape
i) Portrait Reversed
() Landscape Reversed

Display and options shown for

X cos

Select the screen from the drop-down list:
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Gen4-ulLCD-280T e
Gen4-ulLCD-230T ”
Gend-uLCD-32D

Gen4-uLCD-32D-CLE
Gen4-uLCD-320T
Gen4-uLCO-32DCT-CLE |,
Gen4-uLCD-350
Gen4-uLCD-350-CLEB
Gen4-uLCD-350T v
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Define the orientation among the four options:

Orientation
(@) Portrait
(C) Landscape
(") Portrait Reversed
(J Landscape Reversed

Confirm by clicking on or deny by clicking on X Cancel

10. Basic and Extended Graphics Specific Menus

The Arduino compatible Basic and Extended Graphics environments include all the menus available with the ViSi
Environment with some additional options for Arduino Comms which can be found under Comms tab.

Status at 9:30:03 AM
Device is not responding COM3 (4Duina)

COM 1

S

Comms Arduino Comms

The Arduino Comms refers to the COM port that the Arduino board is currently using.
The main difference between the Basic and Extended Arduino environments lies on the available widgets.
Since the Basic Environment is designed to allow users to create projects without the need for a uSD card, it only

allows the user to use primitive shapes and objects in the WYSIWYG window. The Extended Graphics on the other
hand gives additional support for 4D Graphics.
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WORKSHOP4 IDE

11. Connect the Module

Connect the module to a USB port with the 4D Systems programming cable and select the Comms menu:

Above the Comms section, the violet light mentions no module is currently connected.

[—T] Please select an

.. available port

Comms

Connect the 4D Systems programming cable/adaptor to the module and plug the cable into the USB port. Click on the

drop-down list and select the COM port relating to the 4D Programming cable/adaptor.

COM13
COM19
COoM20
COoM21
COomM22
COM23
COM24

Please select an
available port

m

Comms

changing onChanged [x]

The light turns yellow while the connection is being established:

COoM 3

N

Status at 11:15:45 AM
Scanning Port

Comms

Finally, the light goes m when the connection is established.

COM 3

Status at 11:15:45 AM
Gen4-ulLCD-32DCT-CLB-A [v2.0, 16/05/17]

Comms

The light turns @ when no module is attached to the selected port:

COM 3

Status at 11:24:14 AM
Device is not responding

Comms
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12. Insert the Micro-SD Card

For Picaso, Picaso Lite, and Diablo16, the micro-SD card shall be FAT16-formatted. Partition can't exceed 4 GB. For
Goldelox, the micro-SD card shall not be formatted at all, it requires the SD card to be RAW.

To connect the micro-SD card, either:
e Insert the micro-SD card into the USB adaptor and plug the USB adaptor into an USB port of the PC.

Or
e Insert the micro-SD card into a micro-SD to SD card converter and plug the SD card converter into the SD
card slot of the PC.

Check the micro-SD card is mounted, here as drive E:.

@O- %, Computer » G| [ o
o=
Organize = AutoPlay Eject  Properties System properties Uninstall or change a program > B~ 0 @
't Favorites 4 Hard Disk Drives (2) 1
| Local Disk (C:) Recovery (D:)
4 Libraries —> 1 —
591 GB free of 676 GB S .26 6B free of 21.4 GB
*d Homegroup 4 Devices with Removable Storage (2}
4 Remavable Disk (F;)
15 Computer $ DVD RW Drive (E:) =
= = W 155 GB free of 186 G8
&, Local Disk () _
(a Recovery (D:)
= Removable Disk (F:)
€ Network
Removable Disk (F) Spacewsed: L | Total size: 1,86 GB
w” FRemovable Disk Space fres; 1,85 GB File system: FAT

It is highly recommended to use the Workshop4 Tool called RMPet when formatting and partitioning your microSD
card in your PC, for use in 4D Systems modules.

For Goldelox, if prompted to format the SD card, click no/cancel. Leave the card unformatted and Workshop4 will
handle the rest.
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13. Revision History

1.0 First Release 19/11/2012
1.1 Typos on Page 4 fixed 17/12/2012
1.2 Added new content for Serial and fixed incorrect document references 04/02/2013
1.3 Amended details about Micro-SD card 05/07/2013
1.4 Amended details about Program Destination 11/03/2014
2.0 Updated formatting and contents 01/052017
2.1 Added information on target flash banks 29/07/2017
2.2 Updated Formatting 05/04/2019
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14. Legal Notice

Proprietary Information

The information contained in this document is the property of 4D Labs Semiconductors and may be the subject of
patents pending or granted, and must not be copied or disclosed without prior written permission.

4D Labs Semiconductors endeavours to ensure that the information in this document is correct and fairly stated but
does not accept liability for any error or omission. The development of 4D Labs Semiconductors products and services
is continuous and published information may not be up to date. It is important to check the current position with 4D
Labs Semiconductors. 4D Labs Semiconductors reserves the right to modify, update or makes changes to
Specifications or written material without prior notice at any time.

All trademarks belong to their respective owners and are recognised and acknowledged.
Disclaimer of Warranties & Limitation of Liability

4D Labs Semiconductors makes no warranty, either expressed or implied with respect to any product, and specifically
disclaims all other warranties, including, without limitation, warranties for merchantability, non-infringement and
fitness for any particular purpose.

Information contained in this publication regarding device applications and the like is provided only for your
convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with
your specifications.

Images and graphics used throughout this document are for illustrative purposes only. All images and graphics used
are possible to be displayed on the 4D Labs Semiconductors range of products, however the quality may vary.

In no event shall 4D Labs Semiconductors be liable to the buyer or to any third party for any indirect, incidental,
special, consequential, punitive or exemplary damages (including without limitation lost profits, lost savings, or loss
of business opportunity) arising out of or relating to any product or service provided or to be provided by 4D Labs
Semiconductors, or the use or inability to use the same, even if 4D Labs Semiconductors has been advised of the
possibility of such damages.

4D Labs Semiconductors products are not fault tolerant nor designed, manufactured or intended for use or resale as
on line control equipment in hazardous environments requiring fail — safe performance, such as in the operation of
nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines or
weapons systems in which the failure of the product could lead directly to death, personal injury or severe physical
or environmental damage (‘High Risk Activities’). 4D Labs Semiconductors and its suppliers specifically disclaim any
expressed or implied warranty of fitness for High Risk Activities.

Use of 4D Labs Semiconductors’ products and devices in 'High Risk Activities' and in any other application is entirely
at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless 4D Labs Semiconductors from any
and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any 4D Labs Semiconductors intellectual property rights.

15. Contact Information

For Technical Support: www.4dlabs.com.au/support
For Sales Support: sales@4dlabs.com.au
Website: www.4dlabs.com.au

Copyright 4D Labs Semiconductors 2000-2019.
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